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1 Introduction 

This guide covers how to update Cloud Cap Technology products with the latest software and 

firmware. The software and firmware should be updated when new versions are released. Since 

the hardware and software work in sync with one another, they should be updated at the same 

time with the latest release.  

Software and firmware are available from the Downloads page at www.cloudcaptech.com.  

1.1 Items Needed 

 Programming serial cable: Included 

in the Developers Kit. Used for 

updating the Piccolo, TASE Gimbal, 

and the Desktop Ground Station 

firmware (Figure 1). 

 Gimbal programming cable: 

Included in the Gimbal Developers 

Kit. Interfaces between the TASE 

gimbal and programming serial cable 

(Figure 2). 

 9-Pin standard serial cable: Included 

in the Portable Ground Station Kit. 

Used for updating the Portable Ground 

Station firmware (Figure 3). 

 Piccolo interface cable with 6-pin 

MTE connector: Included in the 

Developers Kit. Provides multiple 

connections including PC and autopilot 

power (Figure 4). 

 PC with a serial port: A standard PC 

with a serial port will suffice. If using a 

laptop, a serial port adapter may be 

required. CCT recommends the 

PA088U USB-Serial adapter from 

Targus. 

 

Figure 1 - Programming Serial Cable 

 

 

Figure 2 - Gimbal Programming Cable 

 

Figure 3 - 9-Pin Standard Serial Cable 

 

Figure 4 - Piccolo Interface Cable 

http://www.cloudcap.com/
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2 Hardware Connection Diagrams 

2.1 Gimbals 

The gimbal programming cable plugs in to the auxiliary interface connector on the gimbal 

and the 6-pin MTE connector of the Piccolo programming cable. The PC serial connector on 

the primary gimbal interface cable should be disconnected from the PC during programming.  

 
CAUTION! Do not connect the programming cable during normal gimbal operation.  

 

 

Figure 5 - Gimbal Programming Connection Diagram 

2.2 Piccolo Autopilot 

Connect the programming cable to the 6-pin MTE connector on the Piccolo interface cable. 

Connect the DB-9 serial connector of the programming cable to the PC serial port. 

 

Figure 6 - Piccolo Autopilot Programming Connection Diagram 

6-Pin MTE 
Connector 

Programming Cable 

 

Program 

 

User 

 

Reset 

 PC with 
Gimbal UI 

 

Gimbal    

 
GPS 

Video 

Auxiliary 

 
Primary 

DC 12V Power 
Supply     

 

Gimbal 
Programming 

Cable 

PC Serial 
Connector 

Disconnected  

DB-9 
Serial 

Connector 

 

 

6-pin MTE 
Connector 

Piccolo Autopilot 

DB-9 Serial 
Connector 

Programming Cable 

 

Program 

 

User 

 

Reset 

 

PC 

 

Pitot Static 

GPS COMM 

Piccolo 
Interface 

Cable 

DC Power Supply 



 www.cloudcaptech.com | sales.cct@goodrich.com | Tel. +1.541.387.2120 | Fax +1.541.387.2030 

 

CCT Systems Software Update Guide 9-28-11                                                        Page 5 of 10 

Goodrich ISR Systems 

2.3 Desktop Ground Station 

Connect the 6-pin MTE connector on the programming cable to the Program Port of the 

Desktop Ground Station. Connect the DB-9 serial connector of the programming cable to the PC 

serial port. 

 

Figure 7 - Desktop Ground Station Programming Connection Diagram 

2.4 Portable Ground Station (PGS) 

Connect the 9-pin serial cable to the PC serial port and the Link 2 Config serial port of the 

PGS. The PGS has built in programming hardware so there is no need to use the programming 

cable. 

 

Figure 8 - PGS Programming Connection Diagram 
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3 Saving the Piccolo Autopilot Parameters 

Before updating the Piccolo autopilot, as a precautionary measure, it is recommended to save all 

the current autopilot parameters. 

When upgrading firmware (older version to a newer version) the new firmware may convert the 

parameters stored in the autopilot from the old format to the new format. If you are loading an 

older version of firmware, the parameters stored in the autopilot may be set to their default 

values by the old software. In this case you must use the saved parameters to restore the autopilot 

settings. 

You can save the autopilot parameters over your established wireless comms link, or you can 

direct connect to the Piccolo using the programming cable. 

1. Start the Piccolo Command Center. Power up the Piccolo. 

2. Verify that you are you are communicating with the Piccolo.  

Note: If you using the program cable and are not communicating with the Piccolo, set the 

Programming cable to Program. Wait at least 60 seconds for the PCC to communicate 

with the Piccolo. Set the programming cable back to User.  

3. From the main PCC menu, go to Window » Preflight Windows » Preflight  

4. In the Preflight window, click the Save all button. Name and save the XML file to 

a convenient directory. Do this for each autopilot that you are updating.  

 

Figure 9 - Preflight Window 

4 Updating the System Software 

Use Table 1 to select the appropriate installer file for the software you are updating. The installer 

files are available in the latest software release available on the Downloads page at 

www.cloudcaptech.com. 

1. Open the appropriate installer file on your PC.  

2. If you have previously installed the software, the installer will ask you to repair or 

remove the software. Select Repair and continue. If you have never installed software, 

the installer will guide you through the installation process.  

http://www.cloudcap.com/
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Table 1 - Installer Table 

Software Name Installer File 

Piccolo Command Center – 2.x PccInstaller.msi 

Piccolo System Software – 2.x PiccoloInstaller.msi 

Operator Interface (OI) – 1.x OperatorInterfaceSetup.msi 

Gimbal UI – 1.x GimbalUI.msi 

Gimbal System Software - 1.x - 2.x GimbalInstaller.msi 

ViewPoint - 2.x ViewPointInstaller.msi 

Check the Cloud Cap Technology website periodically for the latest software and firmware 

updates. Join our list if you would like to be notified of the latest product and software updates. 

5 Updating the Firmware  

Before updating the firmware on your CCT hardware systems, it is recommended to run the 

latest Piccolo and/or Gimbal system software installer(s). Along with updating the system 

software on your PC, it also installs the latest firmware files that you will use to update the 

Piccolo and/or Gimbal system hardware. 

Updating the firmware consists of the following steps: 

1. Connecting the hardware.  

2. Placing the hardware in program mode. 

3. Selecting the appropriate firmware. 

4. Uploading the firmware to the 

hardware. 

5. Resetting the hardware. 

5.1 Firmware Versions 

The table below matches the hardware with the firmware version and firmware file. The 

firmware files are available in the latest software release from the Downloads page at 

www.cloudcaptech.com. 

Table 2 - Firmware Table 

Firmware Hardware Firmware Versions Notes 

PiccoloFWG2.mot 

PiccoloHeliNet.mot 

PiccoloFWG3.mot 

Piccolo Plus, Piccolo II, 
Piccolo LT, Piccolo SL 

2.0.x  - 2.1.1.x 

 Helicopter firmware 
only available with 
v2.1.0.x » software 

 Piccolo SL must use 
v2.1.1.x » software. 

GroundStation.mot 

GroundStation_NoSBAS.mot 

Portable Ground Station, 
Desktop Ground Station 

2.x  
 

GimbalLTflash.mot 

Gimbalflash.mot 

GimbalT2flash.mot 

TASE LT/ TASE/TASE 
Duo/T2 Gimbals 

1.x - 2.x 

 

http://www.cloudcaptech.com/default.shtm
https://app.e2ma.net/app/view:Join/signupId:38382
http://www.cloudcap.com/
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5.1.1 Satellite Based Augmentation System (SBAS) 

The Satellite Based Augmentation System (SBAS) uses geostationary satellites that broadcast 

corrections for a wide area. They rely on ground based systems that measure reference data. This 

data is compiled and uploaded to the SBAS satellites by SBAS satellite operators, then broadcast 

to GPS receivers. The corrections are similar to DGPS but are not as high performance. WAAS 

is the SBAS system in the United States. With WAAS corrections functional it is possible to 

attain +/-3m horizontal accuracy (one standard deviation), compared to approximately +/-5m 

horizontal with standard GPS. The NoSBAS.mot firmware option disables the SBAS. This may 

be useful when operating in areas where SBAS is available but is not reliable. 

5.2 Firmware Update Procedure  

5.2.1 Option 1: Automatic Programming 

1. Connect the hardware as shown in section 2 Hardware Connection Diagrams.  

2. Power up the hardware. 

3. Placing the Hardware in Program mode: 

 Set the Program/User rocker switch on the programming cable to Program. Firmly 

press the Reset switch to cycle the power off, and then back on. 

 For the Portable Ground Station first make sure the unit is off. Press and hold the 

Program button while simultaneously pressing the Power button. 

4. Select the Firmware Programmer:  

 For Piccolo systems, go to the Start menu on your computer, Cloud Cap 

Piccolo » Tools » Firmware Programmer.  

 For Gimbal Systems, go to go to the Start menu on your computer, Cloud Cap 

TASE » Tools » Firmware Programmer.  

5. Select the Firmware Programmer option from the list shown in Figure 10. This opens 

the Firmware Programmer application and automatically starts the programming 

process. 

Piccolo System Firmware Options 

 

TASE Gimbal Firmware Options 

 

Figure 10 - Firmware Programmer Options 

6. Reset the Hardware. Set the Program/User switch on the programming cable back to 

User. Firmly press the Reset switch to cycle the power off, and then back on. For the 

Portable Ground Station, press the power button to cycle the power off, and then back on. 
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5.2.2 Option 2: Manual Programming 

1. From the Firmware Programmer options list, select Firmware Programmer. This 

opens the Firmware Programmer application. 

2. Click the Browse button and navigate to the firmware you want to use. In the default 

software installation, the firmware files are located in the following directories:  

 Piccolo Firmware: C: » Program Files » Cloud Cap » Piccolo 2.x » Piccolo. 

 Ground Station Firmware:  C: » Program Files » Cloud Cap » Piccolo 2.x » Ground 

Station. 

 Gimbal Firmware: C: » Program Files » Cloud Cap » TASE 1.x or 2.x » Gimbal. 

 

Figure 11 - Firmware Programmer 

Note: If you are not using COM1 on the PC to connect to the Piccolo, select the appropriate serial port. 

3. Click the Program button. You should see the time and details of the programming 

process display in the window. The program process should take two to three minutes. 

4. Reset the Hardware. Set the Program/User switch on the programming cable back to 

User. Firmly press the Reset switch to cycle the power off, and then back on. For the 

Portable Ground Station, press the power button to cycle the power off, and then back on. 



 www.cloudcaptech.com | sales.cct@goodrich.com | Tel. +1.541.387.2120 | Fax +1.541.387.2030 

 

CCT Systems Software Update Guide 9-28-11                                                        Page 10 of 10 

Goodrich ISR Systems 

5.3 Troubleshooting 

Problem: A programming error window appears after 

clicking on the Program button in the Firmware Programmer 

dialog indicating that the hardware device is not responding. 

Possible Causes: The most common reason for this error 

window is failing to cycle the power on and off at the 

beginning of the programming process or not FIRMLY 

pressing the Reset switch to cycle the power. Another 

common problem is that the hardware device is not receiving 

power. 

 

Figure 12 - Programming Error 

Solution: Make sure the hardware device is receiving power. FIRMLY press the Reset switch 

to cycle the power on and off where indicated in the programming instructions. If you are still 

having problems, try manually cycling the power on and off, instead of using the Reset switch 

to cycle the power.  

 
Make sure the programming cable is connected to the correct serial port on your PC. 

 


